
Introduction to Attachments 
 

This document contains instructions for setting up and using the Attachments 
feature.  You can now attach files of many different types to a variety of locations 
within Acowin.  Attachments can include word processing documents, 
spreadsheets, graphic images (including scans and digital photographs), and 
Adobe Acrobat PDF files.  Acowin can also work with Microsoft Word to produce 
“merge” documents, which instantly draw information from Acowin to fill in 
customer names, addresses, phone numbers, and other fields on standard 
Master Documents you have prepared in advance. 
 

Creating the Attachment Drive 
To use the Attachments feature of Acowin, you must prepare a special shared 
Attachments folder.  This folder could be on any storage device that can be 
accessed from your Acowin server, including one of the server’s internal hard 
disks, a hard disk on a different network computer, or an external mass storage 
device.  Be sure to allow plenty of space for the Attachments folder - if you attach 
a lot of graphic images and large word-processing documents, the Attachments 
folder could become quite large.  Also, you should make some arrangements to 
have the Attachments folder backed up periodically.  You could add it to the list 
of folders backed up by an automatic unattended tape backup, or you could 
periodically copy the Attachments folder onto a tape, memory stick, CD, or data 
DVD.  Note: the Acowin Backup utility does not back up the Attachments folder!  
It only backs up the Acowin data. 
 
To create the Attachments folder, open the My Computer icon on whichever 
computer you have chosen to contain your attachments.  Navigate to the folder 
where you want to keep the attachments, then pull down the File menu and 
choose New >> Folder.  Name the new folder Attachments.  In the example 
pictured below, the Attachments folder has been added to drive C: of the Acowin 
server computer. 
 

 
 



The Attachments folder must be shared to allow network access.  To activate 
sharing, right-click on the Attachments folder, then choose Sharing and Security.  
Select the option to share the folder on your network, and be sure to also allow 
network users to change the contents of the folder.  In the “simple file sharing” 
mode of Windows XP, the ability to change the contents of the folder is granted 
with a simple check box, as pictured below.  In the more complex Windows file 
sharing system, there will be a Permissions button that you can click to grant 
different levels of access to different groups of users.  You would want to ensure 
that all groups of users have full read and write access to the Attachments folder. 
 

 
 
 
With the Attachments folder shared, your final task is to create a mapped 
network drive on the server.  Every Acowin computer needs such a mapped 
network drive, including the server and all workstations.  On the Acowin server 
computer, open the My Documents icon, then pull down the Tools menu and 
choose Map Network Drive.  You can select any drive letter you wish for the 
mapped drive, but you must choose the same drive letter on all computers.  In 
other words, if the attachment drive is assigned letter “W” on your server, it must 
be assigned letter “W” on all of the workstations, too.  Set the target folder of this 
mapped drive to the shared Attachments folder. 
 
Note: Even if the Attachments folder is a local folder on the server’s hard drive, 
you must create a mapped network drive that is connected to it.  If the 
Attachments folder is on the server’s hard drive, this will leave you with a 
mapped “network” drive that actually points to a folder right on the server’s local 
hard drive.  In the example below, the network drive mapped to the Attachments 
folder is drive letter Y, which you can see at the bottom of the screen, under 



Network Drives.  Drive letter “Y” would need to be mapped to the Attachments 
folder on all of the Acowin computers. 
 

 
 
Once you have created the mapped network drive for the Attachments folder, go 
to Setup / Settings / Miscellaneous in the Acowin program. 
 

 
 



On the Miscellaneous setup screen, you’ll see a field called Attachment Drive.  
Enter the mapped network drive letter of the Attachments drive in this field.  In 
our example above, this would be drive letter “Y”.  In the Attachment UNC field, 
enter the computer name and share name of the Attachments folder, in this 
format: \\server\share, where “server” is the name of the computer holding the 
Attachments drive, and “share” is the name the Attachments folder was shared 
under.  This is the same path your mapped network drives are pointing to.  Click 
Save to save your changes after you enter the Attachment Drive letter.  The 
Attachments system is now set up and ready to use. 
 

Specifying File Extensions 
Every Windows data file ends in a three-letter “extension”, which is meant to 
indicate what type of file it is.  For example, files that end with the extension “.jpg” 
are JPEG image files, while the extension “.doc” indicates a Microsoft Word 
document.  Acowin allows you to provide a short description for each file 
extension, making it easy for you to tell what kinds of files are stored in the 
Acowin Attachments system. 
 
To specify file extensions and descriptions, go to Setup / Settings / Attachment 
Extensions.  You’ll see that many of the most popular file types are already 
listed and described.  For example, the extension “PDF” is already listed as 
“Adobe Portable Document Format.”  You can click the New button to add new 
file extensions and descriptions to this list.  Click the Save button to save your 
work when done making additions or revisions. 
 

 
 

Attaching Files to Acowin Entries 
You can attach files to the following locations in Acowin: 

• Customers 



• Sites 
• Equipment 
• Call Slips 
• Contracts 
• Project Management 
• Purchase Orders 
• Receiving Slips 
• Vendors 
• Vendor Bills 
• Inventory 

 
Each of these locations has an Attachments button, which contains the image of 
a folder, as pictured below. 
 

 
 
When you click the Attachments button, you’ll see a list of all the files that have 
already been attached to the selected record.  Remember that Customers and 
Sites have different lists of Attachments, even though they’re two sides of the 
same Customer/Site File.  A Customer can have its own list of Attachments, and 
each of its work Sites can also have its own list of Attachments. 
 

 
 

You can select one of the existing attached files and click the Open File button to 
view it.  The application associated with the chosen file will launch automatically. 
 
You can click the Add File button to select a new file and turn it into an 
Attachment.  The standard Windows file selection window will appear, allowing 
you to locate the file you wish to attach.  The file can be stored anywhere you 



can access from your computer, including a CD, memory stick, or other 
removable media.  Virtually any type of file can be made into an Acowin 
attachment. 
 

 
 

After you locate and select the file you wish to attach, you’ll be asked to provide a 
short description of the file.  Click the OK button when done.  The file will be 
added to the list of Attachments for the chosen Customer, Site, Contract, or Job. 
 

 
 
If you want to remove a file from the list of Attachments, select the file and click 
the Delete File button. 
 

Changing Associated Applications 
You can review or change the applications associated with each file type in 
Windows, by clicking Start / Control Panel / Folder Options, and choosing the 
File Types tab.  The example below shows how files ending in “.csv” are 
associated with Microsoft Excel.  You can change the associated applications 
from this screen, if you wish.  Note that many applications will automatically offer 
to associate themselves with the types of file they can handle when you install 



them.  For example, if you install a graphics design program, it will probably offer 
to associate itself with all of the graphic file types it can handle. 
 

 
 

Creating Master Merge Documents 
Acowin has the ability to merge Customer, Site, Contract, or Job data with 
standard “form letters” created with Microsoft Word.  To take advantage of this 
feature, you can create a set of Master Documents, which are like “templates” 
that include designated locations for customer names, addresses, phone 
numbers, Job numbers, or other important information.  When you create a 
merge document, Acowin will automatically replace these “place holder” marks 
with the correct information.  You must have Microsoft Word installed on your 
system to take advantage of this feature. 
 
To create Master Documents, go to Setup / Settings / Master Document 
Setup.  You’ll see a list of all the Master Documents you’ve already created.  The 
Select Type pull-down menu will allow you to review the four different types of 
Master Document: Customer, Site, Contract, and Job.  These are totally separate 
document types, since each one has different fields available for use in creating 
the Master Documents.  The example pictured below is a list of the Master 
Documents that are suitable for use with Customers. 
 



 
 
To create a new Master Document, click the Add File button.  This will launch 
Microsoft Word.  You’ll see that a special pull-down menu called Insert Merge 
Field.  Clicking this pull-down menu gives you a list of the fields available from 
Acowin, and drops a “place holder” at the current position of your cursor.  For 
example, selecting the Customer City, State, and Zip field inserts a merge field 
called ((custcsz)) in the Master Document, setting the space where the 
customer’s city, state, and zip code will go, each time you create a merge 
document.  You can use as many of these merge fields in your Master Document 
as you want, and you can use the same merge field several different times at 
different locations in the document.  Here’s an example of a Master Document for 
the Customer data, designed to serve as a customer satisfaction survey: 
 



 
 
Notice how the merge fields have been used to set up the customer’s name, 
address, phone number, and e-mail in the upper part of the page, plus the 
salutation to “Mr. Or Mrs. ((lastname))”.  
 
When you’re finished with the Master Document, be sure to save it, by pulling 
down the File menu of Microsoft Word and choosing Save, or clicking the Save 
button on the Microsoft Word toolbar.  You can then close or minimize Microsoft 
Word.  You’ll see a window from Acowin, requesting that you give the new 
Master Document a description, then click OK to save it. 
 

 
 



Creating Merge Documents 
Once you’ve created some Master Documents, you can produce merge 
documents by clicking the button that looks like the Microsoft Word symbol.  This 
button is found right next to the Attachment button, in the Customer/Site File, 
Contract File, and Job File. 
 

 
 
When you click the Merge button, you will be asked to give a Description to your 
new merge document, and then click Next. 
 

 
 
 
You will see a list of Master Documents available for the type of merge you’re 
performing.  Remember there are different types of Merge Document for 
Customers, Sites, Call Slips, Contracts, and Jobs.  Select a Master Document 
and click Next. 
 



 
 

 
The system will launch Microsoft Word, then use the information from your 
selected Customer, Site, Contract, or Job to fill out all the fields in the Master 
Document you have chosen.  The result will be a document personalized for the 
customer or project you’re working with.   The example below uses the 
“Customer Satisfaction Survey” that was used as an example for creating a 
Master Document, above.  Note how all the merge fields have now been 
replaced by the information for the specific Customer that was selected for this 
merge document. 
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